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3. COMPUTER ORGANIZATION 

2 MARKS 

1. What are the parameters which influence the characteristics of a microprocessor? 

A Microprocessor’s performance depends on the following characteristics: 

 Clock speed 

 Instruction set 

 Word size 

2. What is an instruction? 

A command which is given to a computer to perform an operation on data is called an instruction. 

3. What is a program counter? 

The program Counter (PC) is a special register in the CPU which always keeps the address of the next 

instruction to be executed. 

4. Program counter? 

High-Definition Multimedia Interface is an audio/video interface which transfers the uncompressed 

video and audio data from a video controller, to a compatible computer monitor, LCD projector, digital 

television etc. 

5. Which source is used to erase the content of a EPROM? 

 Erasable Programmable Read Only Memory is a special type of memory which 

Serves as a PROM, but the content can be erased using ultraviolet rays.  

 EPROM   retains its contents until it is exposed to ultraviolet light. The ultraviolet light clears its 

contents, making it possible to reprogram the memory. 

6. Define instruction set? 

Basic set of machine level instructions that a microprocessor is designed to execute 

Is called as an instruction set. 

7. What is word size? 

The number of bits that can be processed by a processor in a single instruction is called its word size. 

Word size determines the amount of RAM that can be accessed by a microprocessor at one time and 

the total number of pins on the microprocessor. 

8.  Define bus? 

A bus is a collection of wires used for communication between the internal components of a computer. 

9. What is access time? 

The time taken to read or write a character in memory is called access time. 
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10. What is system bus? 

The system bus is a bunch of wires which is the collection of address bus, data bus and control bus that 

serves as communication channels between the Microprocessor and other devices. 

11. What is meant decoder? 

Decoder, a digital circuit is used to point to the specific memory location where the word can be 

located. 

12. What is a computer organization? 

Computer organization deals with the hardware components of a computer system. It includes input/ output 

devices, the central processing unit, storage and primary memory.   

3 MARKS 

1. Differentiate Computer Organization from Computer Architecture. 

Computer Organization Computer Architecture 

Computer organization deals with the hardware 

components of a computer system. It includes 

input/ output devices, the central processing unit, 

storage and primary memory.   

Computer architecture deals with the engineering 

considerations involved in designing computer.  

2. Classify the microprocessor based on the size of the data. 

 8-bit microprocessor 

 16-bit microprocessor 

 32-bit microprocessor 

 64-bit microprocessor 

3. Write down the classifications of microprocessors based on the instruction set. 

 RISC stands for Reduced Instruction Set Computers. 

 They have a small set of highly optimized instructions. 

 Complex instructions are also implemented using simple instructions, thus reducing the size of 

the instruction set. 

 Examples of RISC processors are Pentium IV, Intel P6, AMD K6 and K7. 

4. Differentiate PROM and EPROM. 

PROM EPROM 

PROM is a memory on which data can be written 

once. 

EPROM is a memory on which ultra violet rays are 

used to clear its contents and making it possible to 

reprogram the memory. 

Programmable Read Only Memory Erasable Programmable ReadOnly Memory 
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5. Write down the interfaces and ports available in a computer. 

Serial Port:  

To connect the external devices, found in old computers. 

Parallel Port:  

To connect the printers, found in old computers. 

USB Ports:  

To connect external devices like cameras, scanners, mobile phones, external hard disks and printers to 

the computer. 

USB 3.0  

It is the third major version of the Universal Serial Bus (USB) standard to  connect computers with 

other electronic gadgets. 

VGA Connector:  

To connect a monitor or any display device like LCD projector. 

Audio Plugs:  

To connect sound speakers, microphone and headphones. 

PS/2 Port:  

To connect mouse and keyboard to PC. 

SCSI Port:  

To connect the hard disk drives and network connectors. 

6. Differentiate CD and DVD 

CD DVD 

CD stands for Compact Disc DVD stands for Digital Versatile Disc or Digital 

Video Disc. 

The capacity of an ordinary CDROM is 700MB. The capable of storing up to 4.7 GB of data. 

Cd’s are made with the purpose of holding audio 

files as well as program files. 

DVD s are made with the purpose of holding video 

files, movies, substantial amount of program etc. 

 

 

 

 

7. How will you differentiate a flash memory and an EEPROM? 
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FLASH MEMORY EEPROM 

The flash memory allows data to be written or 

erased in blocks. 

The EEPROM requires data to be written or erased 

one by one at a time. 

Flash memory is fater in performance. EEPROM is slower in performance. 

8. Differentiate static RAM and Dynamic RAM? 

 STATIC RAM DYNAMIC RAM 

Static RAM needs to be refreshed less often. Dynamic RAM needs to be refreshed frequently.   

Static RAM is more expensive. Dynamic RAM is less expensive. 

Static RAM are used in cache memory. Dynamic RAM are used in main memory. 

5 MARKS 

1. Explain the characteristics of a microprocessor. 

A Microprocessor’s performance depends on the following characteristics: 

 Clock speed 

 Instruction set 

 Word size 

Clock Speed 

 Every microprocessor has an internal clock that regulates the speed at which it executes 

instructions. 

 The speed at which the microprocessor executes instructions is called the clock speed. 

 Clock speed is measured in MHz (Mega Hertz) or in GHz (Giga Hertz). 

Instruction Set 

 A command which is given to a computer to perform an operation on data is called an 

instruction. 

 Basic set of machine level instructions that a microprocessor is designed to execute is called as 

an instruction set. 

 Data transfer 

 Arithmetic operations 

 Logical operations 

 Control flow 

 Input/output 

Word Size 
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 The number of bits that can be processed by a processor in a single instruction is called its 

word size. 

 Word size determines the amount of RAM that can be accessed by a microprocessor at one 

time and the total number of pins on the microprocessor.  

 Total number of input and output pins in turn determines the architecture of the 

microprocessor. 

2. How the read and write operations are performed by a processor? Explain. 

 The read operation fetches data from memory and transfers to MDR.  

 A single control line performs two operations like Read/Write using 1or 0. Also, the write operation 

transfers data from the MDR to memory. 

 The word in the RAM has the same size (no. of bits) as the Memory Data Register (MDR). 

 If the processor is an 8-bit processor like Intel 8085, its MDR and the word in the RAM both have 8 

bits. 

 If the size of the MDR is eight bits, which can be connected with a word in the memory which is also 

eight bits size. 

 The data bus has eight parallel wires to transfer data either from MDR to word or word to MDR based 

on the control (Read or write).  

 This control line is labeled as R/W, which becomes 1 means READ operation and 0 means WRITE 

operation.  

 The content of MDR and the word before the READ operation. Also, the content of MDR and the word 

after the READ operation. 

3. Arrange the memory devices in ascending order based on the access time. 

1. Cache Memory 

2. Main Memory 

3. Hard Disk. 

Cache Memory 

 The cache memory is a very high speed and expensive memory, which is used to speed up the memory 

retrieval process. 

 Due to its higher cost, the CPU comes with a smaller size of cache memory compared with the size of 

the main memory. 

 Without cache memory, every time the CPU requests the data, it has to be fetched from the main 

memory which will consume more time. 

 The idea of introducing a cache is that, this extremely fast memory would store data that is frequently 

accessed and if possible, the data that is closer to it. 
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 This helps to achieve the fast response time, Where response Time, (Access Time) refers to how 

quickly the memory can respond to a read / write request. 

Hard Disks: 

 Hard disk is a magnetic disk on which you can store data.  

 The hard disk has the stacked arrangement of disks accessed by a pair of heads for each of the disks. 

 The hard disks come with a single or double sided disk. 

Compact Disc (CD) 

 A CD or CD-ROM is made from 1.2 millimeters thick, polycarbonate plastic material. 

 A thin layer of aluminum or gold is applied to the surface. 

 The areas between pits are known as "lands".  

 A motor within the CD player rotates the disk. 

 The capacity of an ordinary CDROM is 700MB. 

Digital Versatile Disc (DVD) 

 A DVD (Digital Versatile Disc or Digital Video Disc) 

 It is an optical disc capable of storing up to 4.7 GB of data, more than six times what a CD can hold. 

 DVDs are often used to store movies at a better quality. 

 The 8 cm DVD has 1.5 GB capacity. 

 Double-layered sides are usually gold-coloured, while single-layered sides are usually silver-coloured, 

like a CD. 

4. Explain the types of ROM. 

Read Only Memory (ROM) 

 Read only memory refers to special memory in a computer with pre-recorded data at manufacturing 

time which cannot be modified. 

 The stored programs that start the computer and perform diagnostics are available in ROMs. 

 Once the data has been written onto a ROM chip, it cannot be modified or removed and can only be 

read. 

 ROM retains its contents even when the computer is turned off. So, ROM is called as a non-volatile 

memory. 

 

 

Programmable Read Only Memory (PROM) 

 Programmable read only memory is also a non-volatile memory on which data can be written only 

once. 

 Once a program has been written onto a PROM, it remains there forever.  
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 Unlike the main memory, PROMs retain their contents even when the computer is turned off. 

 PROM programmer or a PROM burner is used to write data to a PROM chip.  

 The process of programming a PROM is called burning the PROM. 

Erasable Programmable Read-only Memory (EPROM) 

 Erasable Programmable Read Only Memory is a special type of memory which serves as a PROM, but 

the content can be erased using ultraviolet rays. 

 EPROM retains its contents until it is exposed to ultraviolet light.  

 The ultraviolet light clears its contents, making it possible to reprogram the memory. 

 EPROMs are used widely in personal computers because they enable the manufacturer to change the 

contents of the PROM to replace with updated versions or erase the contents before the computer is 

delivered. 

Electrically Erasable Programmable Read Only Memory (EEPROM) 

 Electrically Erasable Programmable Read Only Memory is a special type of PROM that can be erased 

by exposing it to an electrical charge.  

 Like other types of PROM, EEPROM retains its contents even when the power is turned off. 

Comparing with all other types of ROM.  

 EEPROM is slower in performance. 

 

Best wishes from 

p.chandrasekaran 

99420 12999 
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5. OPERATING SYSTEM 

1. What is OS? 

An Operating System (OS) is system software that enables the hardware to communicate and 

operate with other software. It also acts as an interface between the user and the hardware and controls the 

overall execution of the computer. 

2. List the popular Operating System? 

 Windows Series - for desktop and laptop computers. 

 Android - for smart phones. 

 iOS - for Apple phones, i-Pad and i-Pod. 

 Linux - Open source Operating System for desktop and server. 

3. What is multitasking? 

Multiple applications can execute simultaneously in Windows, and this is known as 

“Multitasking”. 

4. List the functions of Windows Operating System? 

 Access applications (programs) on the computer (word processing, games, spread sheets, 

calculators and so on). 

 Load any new program on the computer. 

 Manage hardware such as printers, scanners, mouse, digital cameras etc., 

 File management activities (For example creating, modifying, saving, deleting files and folders). 

 Change computer settings such as colour scheme, screen savers of your monitor, etc. 

5. Explain various versions of Windows? 

VERSION YEAR SPECIFIC FEATURES 

Windows 1.x 1985  Introduction of GUI in 16 – bit Processor. 

 Mouse was introduced as an input device. 

Windows 2.x 1987  Supports to minimize or maximize windows. 

 Control panel feature was introduced with various 

system settings and customizing options. 

Windows 3.x 

 

 

1992  Introduced the concept of multitasking. 

 Supported 256 colours which brought 

         a more modern, colourful look to the 

          interface. 

Windows 95 1995  Introduced Start button, the taskbar, 

 Windows Explorer and Start menu. 

 Introduced 32 - bit processor and 
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          focused more on multitasking. 

Windows 98 1998 • Integration of the Web browser (Internet 

• Explorer) with the Operating System. 

• DOS gaming began to disappear as 

• Windows based games improved. 

• Plug and play feature was introduced. 

Windows NT  • Designed to act as servers in network. 

Windows Me 2000 • It introduced automated system 

diagnostics and recovery tools 

Windows 2000 2000 • Served as an Operating System for business 

desktop and laptop systems. 

• Four versions of Windows 2000 were released: 

Professional (for business desktop and laptop 

systems), Server (both a Web server and an office 

server), 

• Advanced Server (for line-of-business 

• applications) and Data Centre Server 

• (for high-traffic computer networks). 

Windows XP 2001 • Introduced 64-bit Processor. 

• Improved Windows appearance with 

themes and offered a stable version. 

Windows Vista 2006 • Updated the look and feel of Windows. 

Windows 7 2009 • Booting time was improved, introduced new user 

interfaces like Aero Peek, pinning programs to 

taskbar, handwriting recognition etc.and Internet 

Explorer 8. 

Windows 8 2012 • Windows 8 was faster than previous versions of 

Windows. 

• Start button was removed. 

• Windows 8 takes better advantage of 

• multi-core processing, solid state drives 

• (SSD), touch screens and other alternate 

input methods. 

• Served as common platform for mobile and 

computer. 
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Windows 10 2015 • Start Button was added again. 

• Multiple desktop. 

• Central Notification Center for App notification 

and quick actions. 

• Cortana voice activated personal assistant 

 

6. Expalin Elements of a window ? 

Title Bar – The title bar will display the name of the application and the name of the document opened. It 

will also contain minimize, maximize and close button. 

Menu Bar 

The menu bar is seen under the title bar. Menus in the menu bar can be accessed by pressing Alt key and 

the letter that appears Underlined in the menu title.  

Additionally, pressing Alt or F10 brings the focus on the first menu of the menu bar. 

The Workspace 

The workspace is the area in the document window to enter or type the text of your document.  

Scroll bars  

 The scroll bars are used to scroll the workspace horizontally or vertically. 

Corners and borders  

• The corners and borders of the window helps to drag and resize the windows.  

• The mouse pointer changes to a double headed arrow when positioned over a border or a 

Corner. 

• Drag the border or corner in the direction indicated by the double headed arrow to the desired size 

as shown. 

• The window canbe resized by dragging the corners diagonally across the screen. 

 

 

7.How Will You Starting and Closing Applications? 

1.Click the Start button and then point to All Programs. The Program menu appears. 

2. Point to the group that contains the application you want to start, and then click the 

application name. 

3.You can also open an application by clicking Run on the Start menu, and the name of 

the application. 

4.To quit a application, click the Close button in the upper right corner of the application 

window. 

5. You can also quit an application by clicking on File → Exit and File → Close option in 
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Windows 7. 

8. How will you creating files and folders ? 

Method I: 

Step 1: Open Computer Icon. 

Step 2: Open any drive where you want to create a new folder. (For example select D:) 

Step 3: Click on File New  Folder. 

Step 4: A new folder is created with the default name “New folder”.  

Step 5: Type in the folder name and press Enter key.  

Method II: 

In order to create a folder in the desktop: 

Step 1: In the Desktop, right click → New → Folder.  

Step 2: A Folder appears with the default name “New folder. 

Step 3: Type the name you want and press Enter Key. 

9. How will you creating files using WordPad? 

WordPad is an in-built word processor application in Windows OS to create and 

manipulate text documents. 

Click Start  All Programs Accessories Wordpad or Run type Wordpad, click OK. Wordpad 

window will be opened.  

2. Type the contents in the workspace and save the file using File  Save or Ctrl + S. 

3. Save As dialog box will be opened. 

4. In the dialog box, select the location where you want to save the file by using look in drop down list 

box. 

5. Type the name of the file in the file name text box. 

6. Click save button. 

10. How will you creating Finding Files and Folders? 

You can use the search box on the Start menu to quickly search a particular folder or file in the computer 

or in a specific drive. 

To find a file or folder: 

1. Click the Start button, the search box appears at the bottom of the start menu. 

2. Type the name of the file or the folder you want to search. Even if you give the part 

of the file or folder name, it will display the list of files or folders starting with the specified name.  

3. The files or the folders with the specified names will appear, if you click that file, it will directly open 

that file or the folder. There is another option called “See more results” which appears above the search 

box. 

www.Padasalai.Net                                                              www.TrbTnps.com

http://www.trbtnpsc.com/2018/06/latest-plus-one-11th-study-materials-tamil-medium-english-medium-new-syllabus-based.html

www.Padasalai.Net



H.sc First Year (Arts & cs Group)         www.padasalai.net 

p.chandrasekaran 

5. If you click it, it will lead you to a Search Results dialog box where you can click and open that file or 

the folder. 

11. How will you creating Searching Files or folders using Computer icon? 

1. Click Computer Icon from desktop or from Start menu. 

2. The Computer disk drive screen will appear and at the top right corner of that screen, there is a search 

box option.  

3. Type the name of the file or the folder you want to search. Even if you give the part of the file or folder 

name, it will display the list of files or folders starting with the specified name. 

4. Just click and open that file or the folder. 

12. How will you Opening existing Files or Folders ? 

Method 1 

Using the FILE Menu 

1. Select the File or Folder you wish to rename. 

2. Click File  Rename. 

3. Type in the new name. 

4. To finalize the renaming operation, press Enter. 

Method 2 

Using the Right Mouse Button 

1. Select the file or folder you wish to rename. 

2. Click the right mouse button over the file or folder.  

3. Select Rename from the pop-up menu. 

4. Type in the new name. 

5. To finalize the renaming operation, press Enter. 

6. The folder "New Folder" is renamed as MOHI. 

Method 3 

Using the Left Mouse Button 

1. Select the file or folder you wish to rename. 

2. Press F2 or click over the file or folder. A surrounding rectangle will appear around the name. 

3. Type in the new name. 

4. To finalize the renaming operation, press Enter. 

13. How will you   Moving/Copying Files and Folders ? 

Method I-CUT and PASTE 

To move a file or folder, first select the file or folder and then choose one of the following: 

• Click on the Edit  Cut or Ctrl + X Or right click  cut from the pop-up menu. 
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• To move the file(s) or folder(s) in the new location, navigate to the new location and paste it using Click 

Edit  Paste from edit menu or Ctrl + V using keyboard. 

• Or Right click Paste from the popup menu. The file will be pasted in the new location. 

Drag and Drop 

 The right pane of the Disk drive window, select the file or folder you want to move. 

 Click and drag the selected file or folder from the right pane, to the folder list on the left pane. 

 Release the mouse button when the target folder is highlighted (active). 

 Your file or folder will now appear in the new area. 

14. How will you    Copying Files and Folders ? 

Method I - COPY and PASTE 

 To copy a file or folder, first select the file or folder and then choose one of the following: 

 Click Edit  Copy or Ctrl + C or right click Copy from the pop-up menu. 

 To paste the file(s) or folder(s) in the new location, navigate to the target 

 location then do one of the following: 

 Click Edit  Paste or Ctrl + V.  

 Or Right click  Paste from the pop-up menu. 

Method II – Drag and Drop 

 In the RIGHT pane, select the file or folder you want to copy. 

 Click and drag the selected file and/or folder to the folder list on the left, and drop it where you 

want to copy the file and/or folder. 

 Your file(s) and folder(s) will now appear in the new area. 

15. How will you Copying Files and Folders to removable disk ? 

1. Copy and Paste 

2. Send To 

METHOD I - Copy and Paste 

 Plug the USB flash drive directly into an available USB port. 

 If the USB flash drive or external drive folder does NOT open automatically, 

follow these steps: 

 Click StartComputer. 

 Double-click on the Removable Disk associated with the USB flash drive. 

 Navigate to the folders in your computer containing files you want to transfer. 

 Right-click on the file you want to copy, then select Copy. 

 Return to the Removable Disk window, right-click within the window, then select Paste. 

METHOD II - Send To 

 Plug the USB flash drive directly into an available USB port. 
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 Navigate to the folders in your computer containing files you want to transfer. 

 Right-click on the file you want to transfer to your removable disk. 

 Click Send To and select the Removable Disk associated with the USB flash drive. 

16. How will you Deleting Files and Folders ? 

• When you delete a file or folder, it will move into the Recycle Bin. 

To delete a file or folder: 

 Select the file or folder you wish to delete. 

 Right- click the file or folder, select Delete option from the po-pup menu or Click File  Delete or 

press Delete key from the keyboard. 

 The file will be deleted and moved to the Recycle bin. 

17. Write notes about Recycle Bin? 

Recycle bin is a special folder to keep the files or folders deleted by the user, 

Which means you still have an opportunity to recover them? The user cannot access the files or 

folders available in the Recycle bin without restoring it. To restore file or folder from the Recycle 

Bin. 

18. How will you Creating Shortcuts on the Desktop? 

 Shortcuts to your most often used folders and files may be created and placed on the Desktop to 

help automate your work. 

 Select the file or folder that you wish to have as a shortcut on the Desktop. 

 Right click on the file or folder. 

 Select  Send to from the shortcut menu, then select Desktop (create shortcut) from the submenu. 

 A shortcut for the file or folder will now appear on your desktop and you can open it from the 

desktop in the same way as any other icon. 

19. List out the functions of an Operating System ? 

 Memory Management 

 Process Management 

 Device Management 

 File Management 

 Security Management 

 Control overall system performance 

 Error detecting aids 

Coordination between other software and users 

 

20. Differentiate cut and copy options. 

CUT COPY 
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When an object is cut from a document, it is 

completely removed and placed into a clipboard. 

When an object is copied a duplicate of it is placed 

into a clipboard while the original remains in place. 

Ctrl + X and Ctrl + V is the shortcut command for 

cut and paste. 

Ctrl + C and Ctrl + V is the shortcut command for 

cut and paste. 

 

21. Differentiate files and folders? 

FILES FOLDERS 

A file is a collection of data on a single unit. It can 

be anything from a word file to a music, video or 

photo file. 

Folders are places where files are stored. Folders 

can contain folders inside them. 

Files have a size ranging from a few bytes to several 

giga bytes. 

Folders take up no space on hard drive.4 

 

 

 

22. Application window and document window? 

Application window Document window 

The larger window is called the application window. The smaller window, which is inside the application 

window is  called the document window.  

This window helps the user to communicate with 

the application program. 

This window is used for typing, editing, drawing 

and formatting the text and graphics. 

 

 

23. What is Open Source? 

 Open Source refers to a program or software in which the source code is available in the web to the 

general public free of cost. 

 Open Source code is typically created as a collaborative effort in which programmers continuously 

improve upon the source code in the web and share the changes within the community. 

24. what are the advantages of Open Source? 

The advantages of open sources are better security, better quality, more control, no vendor dependence, 

easier licence management. 

25. mention the most popular Linux server distributors in Linux OS? 

 Ubuntu Linux 

 Linux Mint 

 Arch Linux 
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 Deepin 

 Fedora 

 Debian 

 CentOS 

26. how will you log off from Ubuntu OS? 

When you have finished working on your computer, you can choose to Log Out, Suspend or Shut down 

through the Session Indicator on the far right side of the top panel. 

 

 

28 . Differentiate windows Os an Ubuntu OS ? 

 

 

windows Os Ubuntu OS 

Windows is a GUI based operating sytem. Ubnuntu is a Linux based operating systems. 

Windows is a closed source. Ubuntu is an open – source operating system. 

Windows is strictly Microsoft company based. It is based around company canonical and is also 

community based. 

 

29.  Differentiate Thunderbird and firebox in Ubuntu OS? 

Thunderbird firebox  

Ubuntu has in-built email software called 

thunderbird. 

Firebox is a internet browser, you can directly 

browse the internet. 

It gives the user access to email such as Gmail, 

hotmail et., 

It is the fastest browser and numerous features that 

protect you, from viruses and other common 

exploits. 

There are free application for users to view and edit 

, to manage and share videos.  

Firefox has some advanced security measures that 

guard against the spyware and viruses. 

 

30. Differentiate Save, Save As and Save a Copy in Ubuntu OS. 

 

Save:  

 This will save the document without asking for a new name or location. It will over-write  the 

original. 

Save As: 
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 These will prompt you to save the document using a dialog box. You will have the ability to change 

the file name or location. 

Save a copy: 

 This will prompt you to save a copy using the same dialog box as save as. You will have the ability 

to change the file name or location. If you changed the name or location of the document you will be 

working on the original document not the copy. That means if you make additional changes and hen it save 

the original will be overwritten with new changes, but the copy you saved earlier will be left at the state of 

the ‘save a copy’. 

 

 

 

Best wishes from 

p.chandrasekaran 

99420 12999 
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CHAPTER -6 

Introduction to Word Processor 

1. How do you insert pictures in to your document? 

 Open office Writer has the ability to insert and edit images in a more simple way. 

 Place the insertion pointer where you want the image to appear 

 Select Insert Picture From file 

 The insert picture dialog box appears where the picture gallery opens from which the desired picture 

can be selected. 

 If the picture is not in the gallery, then browse the pictures from the folder, choose the desired one 

and Click on the Open button. 

 The selected picture is inserted into the document. 

2. What are the different packages in OpenOffice writer? 

 OpenOffice Writer - Word Processor to create text documents 

 OpenOffice Calc - Spreadsheet to create worksheets 

 OpenOffice Base – Database  

 OpenOffice Impress – Presentation software 

 OpenOffice Draw - Drawing Software 

 OpenOffice Formula - Create formula and equations 

3. What is auto text in writer? 

AutoText allows you to assign text, tables, graphics and other items to a key or key combination. For 

example, rather than typing "TamilNadu" every time you use that phrase, you might just type "tn" and 

press F3. You can also save a formatted Tip as AutoText and then insert a copy by typing "tip" and pressing 

F3. 

4. How do you merge cells in a table? 

 Select the cells to merge. 

 Right click and choose Cell Merge or choose Table Merge Cells from the menu bar. 

5. State the difference between proprietary software and open source software? 

proprietary software open source software 

Microsoft Word developed by Microsoft 

Corporation 

OpenOffice developed by Writer Apache 
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WPS Word developed by  Kingsoft LibreOffice Writer  developed by The document 

foundation 

WordPro developed by  Lotus Corporation Abiword  developed by Abisource 

6. What is the difference between moving and copying text? 

MOVING TEXT COPYING TEXT 

Select the text to be moved 

 

select the text to be copied 

 

Click Ctrl + X or Cut Icon or Edit Cut 

 

Click Ctrl + C or Copy Icon or 

Edit  Copy 

The text is removed from the source 

location and placed in the clipboard 

 

A duplicate copy of the text is made and send to the 

clipboard 

The text is removed from the source 

location and placed in the clipboard 

Take the insertion pointer to the new 

location to be copied 

Take the insertion pointer to the new 

location to be moved and Click Ctrl + V or Paste 

Icon or Edit Paste 

Click Ctrl + V or Paste Icon or 

EditPaste 

 

 

7. What are the different types of orientation? 

Landscape  

The width of the document is more than the height. This is best suited for displaying professional 

photos, invitations, albums, tables etc. 

Portrait  

This is the most common and default orientation . Here, the height of the document is more than the 

width. Normally books, newspapers will be displayed in this format. 

8. How do you insert rows and columns? 

1.Place the insertion pointer in the row or in the column where you would like 

to add new rows or columns and rightclick. 

2. Choose Row –insert  to insert a row or Column Insert – to insert a column. A dialog box will 

appear, from which you can select the number of rows or columns to insert. You can also set the position of 

the new rows or columns to Before or After . 

3. Click OK to close the dialog box. 

9. What are the different ways to save a document? 
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 Click File Save  (or) File Save As (or) Ctrl + S 

 The “Save As” dialog box appears on the screen. 

 Select location to store your document. The default location to store all documents is “Documents” 

folder in Windows. 

 Type your document name in the File Name box. 

 In OpenOffice writer, a document can be protected with a password.  

 You can set a password to protect your document while saving a file.  

 To save a file with password, click on “Save with Password” check box and then click “Save” 

button.  

 Immediately it shows “Set Password” dialog box as given. 

10. Write the steps to change the line spacing of text. 

 Select the entire document by Edit Select All  

 Format paragraph 

 The paragraph dialog box appears, click Indents & Spacing tab 

 In the line spacing option, select the type and click OK button. 

11. What are the different methods to change margin in writer? 

Changing or setting page margins in Openoffice writer can be done in two ways: 

 Using the Rulers - quick and easy, but does not have precise values. 

 Using the Page Style dialog box – can specify precise values for the margins. 

1. Changing page margins - using Ruler 

 The shaded sections of the rulers are the margins. 

 Hold the mouse pointer over the line between the gray and white sections. 

 The mouse pointer turns into a doubleheaded arrow. 

 Hold down the left mouse button and drag the mouse to move the margin and release it at the 

required point. 

 5.The new margin is set. 

12. Using the Page Style dialog box 

To change margins using the Page Style dialog box 

 Right-click anywhere on the page and select Page from the popup menu and 

 select page tab of page style dialog box. 

 In the Margins boxes, specify the values for left, right , top and bottom margins. 

 Click on ok button. 
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13. What are Header and Footer? How do you insert page numbers? 

HEADER: 

The header is a section of the document that appears in the top margin, which displays the title or 

chapter name , author name of a document. 

 

 

FOOTER 

The footer is a section of the document that appears in the bottom margin of the page which 

displays the page number, date, time etc. which gets displayed on all the pages automatically. 

Inserting Header and Footer 

 Select from the main menu Insert Header Default 

 The header text area is separated from the normal text area. 

 In the header area, Enter the text that is to be repeated in all pages or Select Insert Fields 

Title. 

 Select from the main menu Insert Footer Default 

 Place the insertion pointer in the footer part of the page. 

 Select Insert Fields Date to insert date in all the pages. 

Inserting and Formatting page numbers 

 Position the insertion pointer where you want to insert the page number 

 choose Insert Fields Page Number. 

 The page number appears with a gray background 

14. Write the steps to Find and Replace a word with another word in OpenOffice writer? 

OpenOffice Writer has a Find and Replace feature that helps to locate for a text inside a document and 

replace it with another word.  

 Click Edit Find & Replace (or) Ctrl + F 

 Type the text you want to find in the Search for box For Example : To search a word "Bombay" in a 

document and replace with "Mumbai", enter the word "Bombay" in the Search for box. 

 To replace the text with different text, type the new text in the Replace with box Enter the word " 

Mumbai" in the Replace with box and Click Find button , to start the search , the found word is 

highlighted and the first occurance of "Bombay" is highlighted. 

 To replace text, click Replace button. The highlighted word is replaced with the word given in the 

Replace with box. 4. Click Find All, Writer selects all instances of the search text in the document .  

 All occurances of Bombay are highlighted. 
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 Click Replace All button, Writer replaces all matches. This will replace all occurances of "Bombay" 

with "Mumbai". 

 Enable Match case to perform the search case sensitively so that uppercase and lower cases are 

distinguished separately. 

 Enable Whole Words only to make the search more specific to words used separately alone. 

 Explain Page formatting in writer 

 The most important thing in a word processor is how to format the page with elements such as 

margins, numbering, page layout, headers and footers.  

 Formatting your pages makes them look more attractive and makes them easier to read. 

Setting the page size and margins 

Changing page size 

The default page size in writer is 8.5 x 11”, the same as that of a standard A4 printing paper. However, for 

different types of documents, you may need to change the page size. To change the paper size: 

 Select the page whose page size is to be changed. 

 Select Format Page, the page style dialog box appears. 

 Select Page Tab 

 In the paper format group, select the format like A4, legal …. 

 Or the width and height option can be used to set the page size. 

15. How do you insert cells, rows and columns? 

To insert rows or columns inside a table: 

 Place the insertion pointer in the row or in the column where you would like to add new rows 

or columns and right-click. 

 Choose Row         Insert – to insert a row or Column       Insert – to insert a column.  A dialog 

box will appear, from which you can select the number of rows or columns to insert.  You 

can also set the position of the new rows or columns to Before or After. 

 Click OK to close the dialog box. 

16. What is a Watermark? 

 Watermarks are images or text displayed in transparency across the text.   

 To create a watermark, it is best to use a Font works object wrapped in the background.  

 The Wrap Through option inserts an image that overlaps the text which as a result will be 

hidden.   

 To make the text appear, change the transparency of the picture, although the words under 

the image become visible, they may be difficult to read and will appear lighter than the rest 

of the text. 

17. Explain Page formatting in writer. 

 The most important thing in a word processor is how to format the page with elements such 

as margins, numbering, page layout, headers and footers.   

 Formatting your pages makes them look more attractive and makes them easier to read. 
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 Changing Page Size:   

 The default page size in writer is 8.5 x 11”, the same as that of a standard A4 printing paper.  

However, for different types of documents, you may need to change the page size.  To 

change the paper size: 

 Select the page whose page size is to be changed. 

 Select Format        Page, the page style dialog box. 

 In the paper format group, select the format like A4, legal……. 

 Or the width and height option can be used to set the page size. 

18. What is meant by word processing? 

 Word processor is a computer software to create, edit, manipulate, transmit, store and 

retrieve a text document.   

 The above said activities are called as “Word Processing”.  

 In other words, Word processing is an activity carried out by a computer with suitable 

software to create, edit, manipulate, transmit, store and retrieve text documents. 

19. What are the familiar Tamil word processor? 

Tamil OpenOffice writer, Tamil Libre, Kamban 3.0, Mentamizh 2017 there are familiar word 

processors exclusively for Tamil Language. 

 

20. What is called insertion pointer? 

The work space is the blank area which is used to type the content of the file.  A flashing vertical bar 

appears at the beginning of the screen which is called as “Insertion pointer”. 

21. Which is known as word wrap? 

When the text reaches the end of the line, the word is automatically wrapped to the next line.  This 

feature in any word processor is known as “Word Wrap”. 

22. What is the use of Insert Key? 

To insert a text in between if something is left out, the insertion can be made by taking the insertion 

pointer to the current location and Press the Insert Key the newly typed text in inserted, so that the 

existing text moves to the right.  Press the Insert Key again, the text is over written on the existing 

text.  This is called ‘Type over mode’.  You can toggle between the insert mode and type over mode 

by pressing the ‘Insert key’. 

23. What is the purpose of using paste special option? 

When you move or copy information, the paste option is used to send the information as a whole.  

But, to move or copy only some aspects of the data, like only its formatting or only value, the Paste 

Special option is used.  To use the paste special, select the text and apply move or copy, then at the 

destination location, Click Edit       Paste Special (or) press Ctrl + Shift + V, (or) Alt + E + S the 

Paste Special dialog box opens. 

24. What is difference between paste and paste special? 

Paste : Paste is a feature that lets a user cut or copy items from Cells and transfer them to another 

completely. 

Paste Special: Paste Special allows the items being transferred to be formatted to several different 

ways.  Paste Special is a feature found in software like Microsoft Word, Microsoft Excel and Open 

Office. 

25. What is meant by Text formatting? 

www.Padasalai.Net                                                              www.TrbTnps.com

http://www.trbtnpsc.com/2018/06/latest-plus-one-11th-study-materials-tamil-medium-english-medium-new-syllabus-based.html

www.Padasalai.Net



H.sc first year (arts group )                                            www.padasalai.net 

 

                                                                    P.CHANDRASEKARAN PAGE 7 

 

A font is a set of characters in a particular style.  Changing the default appearance of the text 

like changing the font type, size, color, style etc., are called as Text formatting. 

26. What is meant by highlighting? 

Highlighting is used to draw attention to important information in a text.  Highlighting is 

beneficial because it first asks the reader to pick out the important parts, and then gives an effective 

way to review that information later. 

Highlighting can be applied by selecting the text and click Highlighting      icon. 

27. What is meant by hanging indent? 

This is a special kind of indent where the first line of the paragraph along hangs outside 

leaving the rest of the text.  To apply Hanging indent, a negative value is given in the “first line” 

option of the paragraph dialog box. 

28. What is the types different page orientation? 

Page orientation refers to how the document will be displayed on screen and printed.  There 

are two different orientations: 

Landscape:  The width of the document is more than the height.  This is best suited for displaying 

professional photos, invitations, albums, table etc., 

Portrait:  This is the most common orientation.  Here, the height of the document is more than the 

width.  Normally books, newspapers will be displayed in this format. 

 

 

 

29. What is the Function of AutoCorrect? 

AutoCorrect function has the facility to correct the common misspellings and typing errors, 

automatically.  For example, “the” will be changed to “the” which can be done through the menu 

option, Tools        AutoCorrect. 

30. What is meant by table? 

A table is a grid with a specified number of rows and columns.  Tables can often be used as 

an alternative to spreadsheet to organize materials.  A well-designed table can help readers 

understand better what you are trying to convey. 

31. What are the important features which provides OpenOffice writer? 

 Templates and styles. 

 Page layout methods, including frames, columns, and tables. 

 Embedding or linking of graphics, spreadsheets, and other objects. 

 Built-in drawing tools. 

32. How to select a text continuous and discontinuous? 

In any word processor, the text has to be selected for performing any operation like copying moving, 

formatting etc.  This text selection can be done by two methods: 

 Selecting the continuous text. 

 Selecting the non continuous text. 

Continuous text:  To select the text continuously take the insertion pointer to the starting of the text. 

Selecting the continuous text:  To select the text continuously take the insertion pointer to the 

starting of the text. 
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(i) Hold the SHIFT key and drag the mouse across until the required text is selected and then 

release the SHIFT key. 

(ii) The select text can be used for any operation. 

Selection the non continuous text: To select the text not continuously, take the insertion pointer to 

the starting of the text,  

(i) Hold the CTRL key and drag across it till the required text is selected and release the CTRL 

key. 

(ii) The required text is selected for any operation. 

33. How can you change the line spacing adjustment? 

Line spacing determines the amount of vertical space between lines of text in a paragraph.  By 

default, the linens are single-spaced, that is the spacing accommodates the largest font in that line, 

plus a small amount of extra space.  In Open Office, setting line spacing is quite easy through the 

context menu, select the line or word or phrase,  

right–click      line spacing, select the type single, 1.5 or double.  There are seven different types of 

line spacing.  

 Select the entire document by Edit         Select All. 

 Format         paragraph. 

 The paragraph dialog box appears, click Indents and spacing tab. 

 In the line spacing option, select the type and click ok button. 

34. How to insert special characters and equations? 

Many symbols which are used in a mathematical equation like alpha (ά), beta (β), pi?(π) 

etc., are not available on the standard keyboard.  However, representing these characters are very 

much essential in mathematical equations.  To insert such characters, the procedure given below is 

followed: 

 Place the cursor in your document where you want the character to appear. 

 Click on the Insert         Special character. 

 The Special character dialog box appears from which the desired symbol can be selected by 

clicking on the character. 

 As you select each character, it is shown on the lower right, along with the numerical code 

for that character. 

 If you do not find a particular special character you want, try changing the font selection. 

 Click the OK button and the character is inserted at the current location. 

35. What are the steps needed to create watermark? 

 Insert the image or text of your choice. 

 Anchor the image to the page and  

 Select the wrap through option from the Format       Wrap menu or right-clicking on the 

image and selecting Wrap. 

 Wrap Through from the pop-up menu. 

 Move the image into the desired position. 

 The picture toolbar should be displayed when the image is selected. 

 Change the transparency to a suitable value so that the text can be read. 

36. How can you merging and splitting cells? 

To merge a group of cells: 
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 Select the cells to merge. 

 Right click and choose Cell        Merge or choose Table        Merge cells from the menu 

bar. 

To split a cell: 

 Place the insertion pointer inside the cell. 

 Right click and choose Cell       Split, or choose Table       Split Cells from the menu bar. 

 Select the direction of the split, horizontally (for rows), or vertically  

(for columns), as well as the total number of cells to create. 

37. Explain the menu bar in OpenOffice writer? 

Menu Bar:  The menu bar is just below the title bar which comprises of various menus consisting of 

various options.  

File:  The File menu contains the commands of all file management tasks like, Create a new file, 

Open an existing file, Close the current file, Save a file, Save As another file, print file, Export file 

etc., 

Edit :  The Edit menu contains the editing commands like,cut,copy,paste,Undo,Redo etc.,  

View: The View menu contains the commands which are used to modify the environment of write 

like display of toolbars, web layout, print layout, navigator etc., 

Insert :  The Insert menu contains commands for interesting various elements such as pictures, 

tables, charts, comments, headers, footers, special characters, cross reference etc., 

Format :  The Format menu contains the commands of various text and page formatting features 

like page size, layout, font characteristics, bullets and numbering etc., 

Tables :  The Table menu contains various tools to manage and manipulate tables such as create 

table, insert rows, insert columns, split cells, merge cells etc.,  

Tools :  The Tools menu contains various tools and functions such as spell check, macros, mail 

merge, end note / footnotes etc., 

Window :  The window menu shows display options such as New Window, Close Windows, Split 

and Freeze. 

Help : The Help menu lists out the inbuilt help features available with OpenOffice. 

38. What are the different shortcut keys of moving within a document? 

There are different ways of moving within a document.  There are many shortcut keys given in Table 

which are used to move easily within a document. 

KEY ACTION 

     → To move a character right  

    ← To move a character left 

    ↑ To move one line up 

   ↓ To move one line down  

     Ctrl + → One word right  
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      Ctrl +← One word left 

     Ctrl +  ↑ One paragraph up 

     Ctrl +  ↓ One paragraph down 

     Home  To the beginning of line 

     End  To the end of line 

     Ctrl + Home  To the beginning of document  

     Ctrl + End To the end of document  

     Tab To move one cell to right 

     Shift + Tab  To move one cell to left 

     Pg Up (Page Up) To scroll one screen up 

     Pg Down(Page Down) To scroll one screen down 

 

Best wishes from 

p.chandrasekaran 

99420 12999 
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